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FileMaker News 8'r Notes
This issue of the newsletter is quite late. I apologise and hope we

have not caused you an inconvenience. The newsletter remains in busi­
ness (and will for a long time) even if it doesn't always seem like it. Well
probably have a few new issues quickly in a row, especially after File­

By
Joe Kroeger

Maker Pro arrives.

Facilities
New +

conjunction with other changes, this means several nice things:
Elk Horn Pub l ish ing has moved into a n ew , im p roved of f ice. In

• There will now be someone to answer the phone, at least most of the
time, even when your editor is out.
• There are more phone lines now so there will be fewer busy signals
when you call.

• There is now a dedicated FAX machine so you can FAX stuff to us.
• Charge cards can now be accepted for subscriptions and renewals.

0 Th e old PO Box address is stil l active and we are stil l showing it on
the cover. Our new street address is:

New
Address Elk Horn Publishing

64A Penny Lane
Watsonville, CA 95076 USA

New
Phones

The new voice phone number is 408-761-5466. Please delete our
old phone number from your records. The new FAX number is 408­
761-5468.

0
Template
Catalog

Domestic US subscribers will soon be receiving (at long last!) a
copy of the new template library catalog. I hope you like it. The US gov­
ernment puts up bar r iers against export ing templates. If we overcome
them we may one day be able to sell templates to FileMaker users
outside the US.

Q
FileMaker

Pro

Delivery of the new FileMaker Pro upgrade has been a little de­
layed. In some ways this is a good sign: Claris is anx ious to remove
every bug they can find. My hope and expectation is that they'll be ship­
ping it in August. The upgrade price for FileMaker Pro wil l evidently be
about $99. While it is true that Pro will be full of great goodies, espe­
cially for those of us who will use it every day, I think $99 is nonetheless
too much. IfI hear of a way to buy the upgrade at a discount, I'll letyou

Article authors for The Fi leMaker Report are paid 104 per word .
You won't get rich, but i t can add up to a few nice bucks. Let me know
if you would l i ke to g ive i t a t r y — I can even suggest some topics.
Template and database authors for the Elk H orn L i b rary are paid a
royalty on each item sold, usually 50%. In addit ion to these payments,
all our authors have their choice of any Library templates at half pr ice.

know.
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More Exploration of FileMaker Pro

Q "FileMaker Pro" is the long-awaited new version of FileMaker that
will probably be on the way soon. While there have been some delays
from the original schedule, I expect that well see the upgrade sometime
in August. The latest pre-release version I have seen is much more
stable and useable than just a month ago, so it is clear that real prog­
ress is being made. Pro includes many new and productive features
that will improve the efficiency of users, enhance the overall effective­
ness of the program and extend the range and complexity of problems
t hat Fi leMaker can conquer. I p red ict you 'l l love i t even at th e h i gh
upgrade price of $99.

By
Joe Kroeger

l 2/18/89
12/20/89
12/26/89
12/27/89
12/28/&9
12/29/89
' I2/31/89
01/D1/90
01/D3/90
01/De/90
D 1 /05/90
01/06/90
01/07/90
01/08/90

01/03/90
01/04/90
o1/os/90
01 /06/90
01 /07/90
01 /08/90
o1/o9/90
01/1o/9o
01/11/90
01/12/90
01/13/90

Uiew IndeH

The FtleMaker Report began describing F i leMaker Pro i n
issue 428 and will gradually increase the space devoted to it. We
will also continue to publ ish ar t ic les describing un iversal t ips,
tools and techniques that can be used with either FileMaker Pro
or FileMaker II. But eventually we expect that most all subscrib­

ers will convert to FileMaker
willPro and the n ewsletter

do the same over time.

P<is te C ance l

The old F i l eMaker I I
View Index dialog (leftmost
figure) uses regular Chicago
12-point type and is a regu­
l ar f ixed box t h a t c a n ' t b e
moved around t h e s c r een.
The new FileMaker Pro View
Index (rightmost figure) is a
movable window that uses
smaller characters. (The two
figures are both shown full
size for comparison.)

Cancel Past e

In spite of the smaller
type size in the new version, fewer l ines of informat ion are shown be­
cause the window is qu i te a b i t sm a l ler . Even though i t i s i n deed a
window, it does not have some window characterist ics: you can't resize
it, you can't br ing the main f ile window in front of it and you can't close
the file unti l you f i rst close the View Index window. It is not c lear why
Claris bothered to make it smaller. The repositioning capability is nice,
and Pro graciously remembers where the window was last located, even
when the file is closed and reopened.

A pop-up list of all layouts is positioned just above the (newly designed)
book icon. This makes swi tching layouts very convenient and saves
using scripts to move between them. The pop-up has a check-mark
next to the active layout.

The ability to name layouts is one of the great new features in Pro.
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More Pro
(continued)

The currently-active layout is al­
ways shown above the book. The
space available there for the name is
only about a dozen characters long.
The pop-up list adjusts to accomodate
longer layout names (see figure to the

right) that are then truncated to fit in

Data Entry...

Issue Sum
By Month
By Product
1.5 Labels
1.0 o Labels

Exceptions

ToDate Sum
srData Entry 8c Update Editing

Layouts:
9

the indicator box above the book.

Layout «I

New Lagout

Name Lagout ¹16

.:-. Tgpe­
Qe Standard
Q Coiumnar report
Q Single page form
Q Labels
Q Enuelope
Q Blank

Cancel

~ DK

When a new layout is created, you have an oppor­
t unity to name i t a t th e same t ime that you p ick t h e
type of layout you desire. (By the way, note in the figure
to the left that we now have six optional starting lay­
outs.) The default name (shown)
can be changed to anything you
d esire. You can even m ak e i t
blank (see figure to the r ight)!
Blank layouts show as blank in
the pop-up l ist and in the ind i ­
cator box. (But the check mark
is not blank, thank goodness.

I'm determined to think of a good use for a blank
layout name. As a security measure? What if I
made all the layouts blank?)

Layouts:
9

Data Entry
ToDate Sum

3'

Issue Sum
By Month
By Product
1.5 Labels
1.0" Labels
Exceptions

Records:
3657

Unsorted

srLayout «I
Layout «2
Layout «3
Layout «4
Layout «5
Layout +6
Layout "7
Layout "8
Layout «9
Layout "10
Layout "11
Layout "12
Layout «13
Layout "14
Layout "15

When an existing file is converted from File­
Maker II, Pro provides names for all the old lay­
outs using a numeric sequence, l ike the f igure
to the left. You can leave them l ike that or, bet­
ter, rename them w i th f u n c t ional names (and
perhaps delete some no-longer-needed scripts
as a result) using the Layout Options com­
mand from the Layout menu. The figure below
shows the "Layout ¹2" name being changed to
"1.5" Label".

Show

Gridlines
Rulers
T-Squares XT
Size
Sample Data

Align to Grid X Y

Define Parts...
Lagout Options...
Ruler Settings...

Base Addr
Layout "2

T..i.
.O.r..
L.a
.S.L

Lagout Options

Name 1 .5 n Label

Bod : :Hnisplop in~3 colu m ns
Layouts:
8

s s

Qe Across firstHR
FieirL............... Q Down fi rst

Access

Cancel

OK
~Part

a A~xlt
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More Pro
Access control to files and fields and layouts is now much more

sophisticated in FileMaker Pro. 'Groups' are defined, passwords are de­
fined and then each can be linked to specific layouts and individual
fields. A password specifies a set of accesses and activities allowed.
This will provide an addit ional level of security and control in a mu l t i ­

(continued)

user environment.

Define Passwords for File "Master Orders"

L950H
A99OC

It is no doubt going
to be great if I can figure
out how to manipulate all
these access tools and
get them to play together.
The trouble is that there
are three nested interact­
ing dialog boxes and the
m anual does no t s a y
m uch about how t o i m ­
plement what you would
like,

,--Priuileges

Q Access the entire file
H Browse records
H Print records
Q Edit records
Q Create new records
0 Delete records
Q Ouerride data entrg warnings
Q Oesign lagouts
H Edit scripts

Password:

(Leaue blank for no password)

Define Groups for File "Master Orders"

Data Entrg
Accounting

Be! et e

Create A~ ce w s

~ chnnga ~s r oups ...

Done

Claris has invented a
new user- interface sty le
f or th i s f u n c t ion a n d I
have not yet been able to
decode it. It seems simple
enough: the program is

trying to tell me to just cl ick on groups,
passwords, f ields and layouts in o rder to
l ink them. Bu t i t j u s t w on' t work for me .
Either it is not work ing yet in the version I
have or I don't understand i t yet .

Louise

Group Name:

Passwords..

Oone

Belet e

ln

ln

ln

A nother n e w t o o l i s th e s i z e b o x
(shown below). In Layout mode, the size
box can be called up and positioned where

you like. It is a floating window that re­
mains active as you work, specifiying loca­
t ions on the layout and heights and widths
as well. The dimensions do not change as
you zoom in and out. Once you've opened
a nd placed th e s ize w i n d ow, i t r e t u r n s
each time you select Layout mode.

Q:.'i..'iiii Size

3.900
1.611
5.250
1.986

1.350

0.375

ln

ln
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Turning Old Customers Into New

Q Some time ago I was asked to modify a FileMaker invoicing file so
that customers who hadn't ordered recently could be found, allowing
special solicitations for more orders. At the time, I scratched my head a
bit then concluded it couldn't be done. The main problem was that the
search involved finding some records based on the existence, or lack
thereof, of other records in the database.

Locatlng Customers
Who have not

Ordered Recently

By
S.C. Kim Hunter
Acropolis Software

T he basic operation is to separate the orders into two groups ­
older orders and recent orders — then find al l cus tomers in the o lder
group who are not in the newer group. This is a complex search which
can't be done directly with FileMaker's Find command. Separating the
two groups is easy: Find wi th an o rder date less than a desired date,
say 30 or 60 days ago. The hard part is omitting customers that are in
both groups.

Complex
Find

Based on a scheme for deleting duplicate records presented in the
Claris Technical Solutions newsletter (January 1990), I began to see
how this could be done with lookups. What is needed in every record in
the Orders file is a field named Recent Order Date. This f ield could be
u pdated manually every t ime an o r der i s p l aced by f i n d ing al l t h e
records for this customer, entering today's date in the Recent Order
Date field, then using the Replace command ( in the Edit menu) to f i l l
this date into all of that customer's records. To send letters to stimulate
new orders, just Find for Recent Order Date less than a specified date,
like 30 or 60 days ago.

Basic
Solution

Procedure...

...Automated

This can be automated by defining an entry opt ion lookup to copy
into the Recent Order Date fie ld f rom the Order Date f ie ld. For rea­
sons to be explained later, it is necessary to use a clone file because of
the way FileMaker does lookups. (If you are implementing as you read,
make a clone of your order f ile now and open it to define the lookup.)

A lookup entry op t ion to copy into the Recent Order Date f ie ld
from the Order Date field is done by choosing De6ne from the Select
menu, clicking the Recent Order Date field name, then clicking Entry
Options. The Entry Options dialog has a check box labeled Look up
value &om another 61e. This can fool you; even though i t says "an­
other" I'ile you can select the name of the same file currently open. So
when FileMaker asks for the name of the lookup f i le, just choose the
name of the clone file you now have open. This kind of lookup is a self­
lookup that has been described before in this newsletter.

Self­

Lookup

As shown in the figure on the next page, when picking the fields for

Copy into: Recent Order Date
From: Order Date
When what is typed in: Customer ID
Matches a value in: Customer ID

the lookup in the clone, speciiy:
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(contlnued)

Old Cusfomers

Copg into:
Recent Order Date

I

Order Date
Recent Order Date

tUhen what is tllped in:

New File
Instead

of Clone

Rats!

If ualue is not found, then: Sw itch Lookup File
® don't copg
0 coeg using neut totuer ualue ~O K ~rancel

I

Order Oate
Recent Order Date

matches a ualue in:

from "Clone of Orders":

Customer IO
I g ' l s

Recent Order Date

The Customer ID field has to be whatever field you use to distinctly
identify each customer. Some use customer or account numbers, some
just the name or the telephone number, others use a calculated name
code joining parts of name and address fields.

the Order Date f ie ld m ight a ppear no b e t ter t han j u s t e n te r ing the
order date manually into the Recent Order
Date f ie ld. Not so. What h a ppens is t h a t
FileMaker searches for the fi rs t occurance
of Customer ID in the fBe, then copies the
Order Date from that found record into the
Recent Order Date of the current record.
Sounds OK, but wait a minute: this process
means that FileMaker is going to copy from
t he older (fi rst) order i n t h e f i l e i n t o t h e
most recent order. That's not what I want.

At first I thought I had a c lever quick
t rick: jus t s or t t h e o r i g ina l o rder f i l e on
Order Date in descending order so that the
most recent dates would be f i rst in the f i le
and, thereby, be the first records found in a
lookup. Sorry; it doesn t work that way. For
lookups, even if a f i le is sorted, Fi leMaker

still searches records in the order entered into the file and always finds
the first-entered matching record for the lookup. This is because File­
Maker searches an index, not the sorted records themselves. Ratsl

Is our scheme doomed? No. The original Orders file can be sorted
by Order Date in descending order, then the Customer ID and Order
Date f ields canbeou tput to a text file. The clone canbe opened and this
data can be input from the text fi le. This produces an unsorted file with
the most recent orders first in the f ile (and in the index). Now the
function of the clone is clear: it provides access via lookup to the most
recent order for each customer. If your Orders f i le is large with many
layouts, you could create a new file instead of using a clone and define
three fields: Customer ID, Order Date, and Recent Order Date, then
define the lookup as specified previously.

before making the clone. If you did that, the clone will stil l do the lookup
into the original orders file. You would have to do a Switch Lookup File
which involves repicking the file name and reselecting the lookup fields.
It is less likely to cause errors to just establish the lookup in the clone.

In this modi f ied clone, cl icking in the Customer ID f i e ld of any
record and choosing Relookup from the Edit menu will copy the most
recent order date for each customer into al l the records for that cus­
tomer. It is important to understand that jus t one relookup operation
will copy all the correct dates into all records in the fi le. You don't have
to repeat the relookup for each customer.

Setting the lookup to copy into the Recent Order Date field from

1

Caution: Don't def ine the lookup op t ion for Re cent Order Date

The FileMaker Report © 1990 Elk Horn PublishingPage 8 Issue 29



(continued)

Old Customers
From the clone file, output only the Recent Order Date field to a

text file. Make sure you know which folder this file is going into and give
it a name distinct from the other text file that was output from the
original orders file. You might be tempted to just open the orders file
and Input From the c lone directly. That won't work. Di rect input can

only add new records, not update ex­
isting ones. Update can only be doneWarning: We are about to update a file. Any time you use

Update existing records you have to be very careful not to
wipe out data. Just to be safe, make a duplicate of the
original orders file before doing anything else.

from text f i les.

Update

Go back to the original Orders file
which should st i l l be sorted by Order
Date in descending order. Choose

Input From on the File menu and select the text file that you output
from the clone. On the Input Order dialog make sure you click the Up­
date existing records option and move only Recent Order Date to the
Input Order lis t. Click Input. In order for an update to work, it is vital
that the exact same set of records are found and that they are sorted
the exact same way.

less than some prior date. For example, Recent Order Date ( 1/1 /9 0
will find all customers who ordered before 1990 and who have not
ordered since. Notice, by golly, that this is what we were after!

When the input is done you can do a Find for Recent Order Date

Summary of the one-time steps to set up
SQL is a new data management programming lan­
guage. SQL is pronounced like the word "sequel"
and means "Structured Query Language". SQL is
becoming popular for many relational database
products. The complex find operation discussed in
this article can be performed using SQL with the
following SQL query:

the process:
1. In the Orders file define a new field: Recent
Order Date. (It is assumed you already have
an Order Date f ield.)

2. Make sure there is a unique field that iden­
tifies each customer, for example, Customer
ID.

3. Make a clone of the Orders f i le.

4. Modify the clone to lookup the Recent
Order Date:

SELECT CUSTOMER ID, ORDER DATE
FROM ORDERS
WHERE ORDER DATE ( 1/1/90
AND CUSTOMER ID NOT IN
(SELECT CUSTOMER ID
FROM ORDERS
WHERE ORDER DATE ) 12/31/89)

This is a g ood example of th e c omplexity o f
relational databases like ORACLE. You have to
know exactly how to type a complex sentence like
this one to get a SQL data program to work for you.
Perhaps it won't be too long before they catch up
with FileMaker's point-and-click simplicity. Before
I wrote this a r t icle I was convinced Fi leMaker
couldn't handle th is F ind . Now we know h ow
simple it is to do. Expanding FileMaker's capability
but keeping it easy to use is a major concern at
Claris (and The F i leMaker Report) as ongoing
FileMaker upgrades are designed.

the Recent Order Date f ie ld:

Lookup file name: the clone itself
Copy into: Recent Order Date
From: Order Date
When what is typed in: Customer ID
Matches a value in: Customer ID

Summary of recurring steps to update

1 . Make a dupl icate safety backup of the
Orders file.

2. Sort the Orders fi le by Order Date in de­
scending order. (Don't forget to cl ick the De­
scending Order button.)
3. Output from the Orders fi le to TextFi le1
the two fields Customer ID and Order Date.— S. C. K. Hunter

The FileMaker Report © 1990 Elk Horn PublishingPage 9 Issue 29



OId Customers
4. Open the modified clone and input from TextFilel.
5. Click Customer ID and choose Reloolrup from the Edit menu.
6. Output the Recent Order Date fie ld from the clone to TextFile2 .

7. Before closing the clone, delete al l records to conserve disk space
and to prepare for next time. Alternatively, just make a clone of the
clone for later use.

8. In the Orders file, input from TextFile2 to update Recent Order
Date, making sure to click the Update existing records button.
9. Find for Recent Orders Date < desired date.

(contlnued)

While this may look a lit tle complicated on paper, it really is a snap
to accomplish once the fi les are set up . F i leMaker's point -and-cl ick
simplicity al lows even fairly complex operations to be implemented in
seconds. And don't forget that you can set up scripts to aid the process
— FileMaker even permits input and output operat ions to be scripted.

With any new data manipulation scheme, it is a good idea to set up
a sample to test the operation of the fi le. And it is best to try to f ind the
simplest possible example to start with before trying more complex
ones. That makes it easier to see if something isn't working correctly.
Try out this scheme with two customers, A and B, and three orders to
make sure your procedure finds customer B but not customer A:

Example

C ustomer ID Ord er D a t e

A 12/12/89

B 12/12/89

A 4/4/90
K53

Editor's note­
Kim's technique in this ar t icle is quite valuable for extracting more
useful information from existing data. Notice that it is based on a sys­
tem that uses a single Orders f ile for both orders and customer ad­
dresses. If you have your files arranged differently, you may want to
consider variations of his approach.

Some order-entry systems use a separate customer address file. When
a new order is entered in the Orders f i le, the customer name and
address are looked up from the Customers fi le. (If a new customer
places an order and is not in the Customers file, the name and address
are entered manually.) The Customers file is then often a convenient
place to keep track of other customer-specific information l ike Kim's
Recent Order Date.

At the Diskette Gazettecustomers, prospects, inactive and bad records
are all kept in the master name and address files. Three dates are
mainta ined with each record: Name Ent ry Da t e , Last Ma i l Da te, a nd
Last Order Date. But a similar problem remains concerning updating
the Last Order Date field and some kind of similar solution needs to be
designed.

— d. Kroeger

The FileMaker Report © 1990 Elk Horn PublishingPage 10 Issue 29



Flaws into Features
I3 One o f the tricks of using any software is to turn peculiarities into

advantages. (This process provides a measure of challenge and fun as
well.) FileMaker's outstanding weakness is repeating fields: they do not
always do proper look ups, won't sort and can't be subsummarized for
such things as sales reports by part number. These flaws are due
primarily to the fact that , for many pu rposes, FileMaker can only see
the first entry in a set of repeating fields. However, in some instances
this problem can become a usable feature.

New Uses ior
Repeating Fields

By
Michael Harris

Mike Harrls ls Presldent of
Watertechnics, a San
Francisco Bay Area
Macintosh consultlng
company, speclallzing in
small business applicatlons.
He can be reached at 408­
423-8927 or write to:
Watertechnlcs
PO Box 2307
Santa Cruz, CA 95063

fields can have several possible entries.
Enhancing Finds Q Con si der an address file illustrated in Figure 1. Some mail l ist

• An entry in the First Name f ield might be 'Robert' or 'Bob' or 'B.L.' or
'Buddie'. When doing a Find for a part icular person, it would be nice if

you did not necessarily have to remember which variat ion was put in to
the field. Or i t m i gh t b e n i ce to d i s t ingu ish among al l t h e 'Robert '
entries, to find the one Robert you th ink of as 'Bob'. This is especially
important if the mail ing list needs to be formal — if nicknames are inap­
propriate for letters and labels.

• In address files without a Company f ie ld, a business name may end
up in the Last Name field, leaving no good place for the contact name at
that company. It would be nice to be able to locate an entry by company
name or by contact name when the other one is not remembered.

• City name entr ies are often ambiguous for small towns, which may
not be known by their 'off icial' USPS city names. For instance, in our
area Bonny Doone and several o ther smal l t owns are really "Santa
Cruz" to the Post Office. It would be nice to be able to find addresses by
these small-town names while at the same t ime conforming to USPS
standards.Fig 1. Typical fields in an

address file formatted
with repeating fields.

Records:

First Name

Robert
Bob
Buddie
B. L.

Last Name

,::Hathawaii
Watertechnics

,::The Workbench Report:

IP.O. Box 2307
hddress

I

City

Santa Cruz
Boong Doone

State Z IP

CA 195063
Telephone

:408 761-5469
406 423-8927
.408 438-2776

e

+
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Using Flaws
• Telephone numbers are notorious proliferators. It is becoming more
common these days for someone in your database to have: a main busi­
ness number, a car phone, a home phone, a Fax number, and a modem
number, or even more.(contlnued)

In all these cases you could, of course, create separate fields to
hold each variation. But this generates larger and more complex files
just to deal with some exceptional records. In addition, separate fields
require separate Find requests. If you had a f ragment of a phone
message, with only a telephone number, it is better to be able to do one
Find in a Phone Number field rather than, say, six finds in six different
phone fields.

f ield where ordinarily you would not . The extra sub-f ields can then be
used for secondary information, or for keywords to help in Finds. All
your usual layouts can show this repeating field as a s ingle field.
A ddress labels, for ins tance, would show only the fi rs t va lue in t h e
First Name f ie ld. That is why th is technique beats simply p lacing al l
values in a s ingle field: a non-repeating field with al l var iat ions sepa­
rated by spaces would do the same job of augment ing Find requests,
but would be much harder to use for ordinary purposes. A special
repeating field data entry layout could be used for enter ing variat ions
and keywords. (see figure I)

A nice way around these sorts of problems is to create a repeating

Use
Repeating

Fields

Limitation
OI'

A Find is easier when FileMaker searches for a value in a repeating
field. It locates all records that have the value you request in any of the
repeating field positions. The reason is that FileMaker indexes every
word in a field and it sees a repeating field as only a specially-formatted
ordinary field.

Advantage?

An excellent use for th is type of repeating field is in re ference or
article indexing. The f irst l ine of the repeating f ield might contain the
t itle of an ar t ic le. Repeating 'hidden' l ines can then be fi l led with key­
words. For the article you are now reading, for instance, keywords
might be 'Lookup', 'Repeating', 'Harris', '29', 'FileMaker Report' , 'Flaws'
and so forth. Now it is possible to do a Find in a f ie ld which might be
named Article Title but the Find can be for any word which might oth­
erwise be in an index. When the found record appears — if you are in a
layout with the repeating field formatted as a single line — the title of the
a rticle wil l appear in t h e f i e ld r a ther t han t h e w or d fo r w h ich y o u
searched. If the layout were formatted for Vi ew As L is t, a g roup o f
relevant articles would appear on screen.

lndexing

This sort of technique can be very elegant. It is also just the sort of
thing which, if stated as a problem, most experienced FileMaker users
would tell you "FileMaker doesn't do .. ."

useful. Match codes are calculated fields designed to help find dupli­
cates in address f i les. A match code typ ically consists of le t ters and
numbers extracted from d i f ferent par ts o f the address. You w i l l see
them on a l l t h e a d d ress labels on y ou r m a gazine subscr ipt ions. A

M ail l ist ma tch codes are another case where th is t r ick can b e
Mail

Match
Codes
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Using Flaws
simple match code might take the first three letters of the subscriber's
last name and the first five numerals of the ZIP code:

Match code
Lea95619

Address
Sherman Leal
445 Elf Street
Diamond Sprlngs, CA 95619

However, when names have several possible spellings, or are prone

(continued)

to spelling errors, match codes can fail. For instance:

Address Match code
Sherman D'Angelo D'A95619
445 Elf Street
Dlamond Springs, CA 95619

Sherrnan De Angelo
445 Elf Street
Dlamond Springs, CA 95619

Sherman Dangelo
445 Elf Street
Diamond Sprlngs, CA 95619

Dan95619

De 95619

Fig 2. Address record
with three variations of
last name and match
code.

Records:
2

First Name Last Name

Sherman ::. D'Angel o

De Angelo
:,Dangelo

Flaw Art ic le

State ZIP

C* l95619

Address

445 Elf Street

Diamond Springs
cite Match Cede

i D'A95619
:. :De 95619

;:Dan95619

Since match codes
are used to locate dupli­
cate records, all three of
t hese va r i a t i on s c o u l d
coexist in a mail l ist, with
a su bscr iber g e t t i n g
three copies of a catalog
or periodical.

[Q Browse

If we have repeating
fields for Last Name, ZIP
and Match Code we have
the possibility of finding
these d u p l i c a tes i f w e
add possible s p e l l i ng
v aria t i on s d u r i ng t h e

original data entry of each address (see Figure 2). Now a search for
match code duplicates will f ind al l three of these records and give us a
chance to delete two, keeping the version we prefer. By retaining the
variations in the repeating fields, we will be able to find any variation
duplicate of this address that might be added in the future. Meanwhile,
of course, none of the less desirable versions of the last name will get in
the way of the normal use of the address.

One of the most common Fi leMaker lookups is customer addresses for
invoices or sales orders. Figure 3 (next page) shows an Invoice record

Improving Lookups Cl Looku ps can also benefit from the selective use of repeating fields.
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Records:
4

(continued)

Using Flaws

P.O. Box 2307

Mail:PO Box 2307
Santa Cruz, CA
95063

1 16/12/90

"" : " " ::" " : :: : : : . .".'.."..'! ." '. ."."1.". .'

MAVIKIRVIKCMMtlCI

HathawaiI

Santa Cruz :':,CA :.'I::95063
408 76'1-5469 ISanta Ci uz ': ,13.5'..0675

Fig 3. Typical Invoice file after lookup with 'Hathaway'
in Last Name field.

Flaw Inuoice

Flaw Inuoice

(408) 423-8927

which can look up addresses based on customer last name. The lookup
takes information from a Customer Address file like that in Figure l .

T he address in F igure 3 w a s
looked up after entry of "Hathaway"
in the Last Name f ie ld. However,
since the Customer Address file has
a repeating Last Name field, either

Report" will also look up the same
name and address. This is demon­
strated in Figures 4 and 5.

phone number is looked up, regard­
less of which line of the repeating set
the Last Name v a lue i s. Th is is t he
lookup 'flaw' mentioned at the outset.
This t e c h n i qu e f o r lo o k u p s i s a
"many-to-one" process. Any match in
the repeating fields grabs the infor­
mation from single fields or from the
first item of a repeating set.

"Watertechnics" or "The Workbench

You will not ice that only the f i rst

MAVIKIRVIKCMMtlCI
Mail:PO Box 2307

Santa Cruz, CA
95063

1 6/12/90

(406) 423-6927

In our consulting business we re­
cently used th is technique to c reate
an inventory f ile for an ant ique busi ­
ness. Since each item in inventory is
unique, no count ing was required. It
was just a question of whether an
item had been sold or not.

Records:
4

Watertechni cs

P.D. Box 2307

Santa Cruz
408 761-5469

Records:
4

Fig 4. Same file after entering 'Watertecnics'.

Mail:PO Box 2307

Santa Cruz, CA
95063

1 6/12/90

MA VtKIRVKCMMtlCI
Flaw Inuoice

The Workbench Report

P.O. Box 2307
Santa Cruz C A 9 5 0 6 3
406 761-5469 S anta Cruz 13.5 .0 6 7 5

C A 9 5 0 6 3

S anta Cruz 13.5 .0 6 7 5

(408) 423-8927

The store's Invoice file was typi­
cal: repeating fields were used to l ist
i tems sold on each invo ice. We cre­
ated a separate Inventory f i le and
made sure every item had a unique
i tem code, and t h a t t h e c o d e w a s
used when invoices were created.

The Inventory f i le was then up­
dated periodically with the Relookup
function: i f the i tem code in the I n ­
ventory file matched an item code in
the Invoice f i le — at any pos i t ion in
the repeating f ield — the Invoice
Number w as looked up i n to t hat i n ­
ventory record. So, sold inventory
i tems became those with some value
in the Invoice Number f ield after the
lookup; unsold i tems are those wi th
blank In v o ice N umber va l ues. We

Fig 5. Same file after entering 'The Workbench Report'.
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(continued)

Using Flaws
were then able to use the Inventory file to do all manner of reports on
inventory status.

invoice date and so could do reports from the Inventory file of items sold
to each customer. The antique store found these reports very valuable
for directing not ices of new pieces to the customers most l ikely to be

Humanizing Computers Q One o f the difficulties with computers is their inability to deal with
ambiguity, to make good judgements about whether two simi lar th ings
a re the same or d i f ferent. Our fami l iar ity with the real world and the
many different ways things can screw up makes us a necessary acces­
sory to the machine. Adding some clues to our perverse variabil i t ies in
Filemaker repeating fields helps shift some of this judgement burden
back onto the computer. Do you suppose this technique qualifies as
"artificial intel l igence"?

Later we also looked up customer name and sales date along with

interested.

Four records created from one for new lookup file.

'. :Bob

First Name

::Robert ,::Hathawag

First Name Last Name

First Name Last Name

First Name Last Name

: Watertechnics

,::Buddie FThe Workbench Report

Last Name

Address

P.O. Box 2507

Address

Address

For our antique store
we were not able to look up
the sales price for sold
i tems because the p r i ces
were also i n r e p eat ing
f ields, not single fields l ike
the Invoice Number. I f
you need correct lookups
from repeating field sets to
r epeating f ield se ts , i t i s
necessary to create a du­
plicate file, without repeat­
ing fields, to be used as the
lookup source f i le. This is
done by "spl i t t ing" records
a s they ar e e n t e red i n t o
t he new f i l e . Th e f i g u r e
s hows how t h e i n f o r m a ­
t ion in Figure 2 would ap­
pear as mult iple records in
the new file. Since the split
records only h ave va lues
in the f i rs t l i nes of f ie lds,
the lookups work .

Address
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